
Product description 

The Mentype® Pentaplex ESS PCR Amplification Kit was developed for multiplex 
amplification of new miniSTR markers and Amelogenin which are recommended by 
ENFSI and EDNAP (Gill et al., 2006). In one PCR reaction, the five polymorphic STR loci 
D1S1656, D2S441, D10S1248, D12S391 and D22S1045 as well as the gender-
specific Amelogenin are amplified simultaneously. The primers are fluorescence-
labelled with 6-FAM, HEX or NED. 
 
These low molecular weight STRs have substantial benefit to detect degraded samples 
so that the maximal amplicon size was restricted to 225 bp within the 
Mentype® Pentaplex ESS. In combination with existing STR markers in use, the new 
markers improve the discrimination power which in turn is important to improve the 
power of national DNA databases. 
 
The detection limit of Mentype® Pentaplex ESS PCR Amplification Kit is about 100 pg 
genomic DNA. However, it is recommended to use 0.2-1.0 ng DNA. 
 
The test kit was validated and evaluated using the GeneAmp® 9700 thermal cycler, 
ABI PRISM® 310 Genetic Analyzer, and ABI PRISM® 3100/3130 Genetic Analyzer. 
 
 
Tabelle 1. Locus-specific information of Mentype® Pentaplex ESS 
Locus GenBank® 

accession 
Repeat motif 
of the reference allele 

Reference 
allele 

Allele 
range 

Amelogenin X M55418    
Amelogenin Y M55419    
D1S1656 NC_000001.9 [TAGA]16 [TGA][TAGA][TAGG]1[TG]5 17   9-21 
D2S441 AL079112 [TCTA]12 12   8-19 
D10S1248 AL391869 [GGAA]13 13   8-21 
D12S391 G08921 [AGAT]5 GAT [AGAT]7 [AGAC]6 AGAT 19.3 13-28 
D22S1045 AL022314 [ATT]14 ACT [ATT]2 17   7-20 
 
Table 1 shows the STR loci with their repeat motifs and alleles that are concordant with 
the International Society for Forensic Genetics (ISFG) guidelines for the use of 
microsatellite markers (Bär et al., 1997). The nomenclature for STR Loci D10S1248 
and D22S1045 is in accordance with Hill et al. (2008). Locus D22S1045 includes a 
trinucleotide STR motive that might result in a special stutter performance (see chapter 
5). Allele ranges include all known alleles of the National Institute of Standards and 
Technology (NIST as at 10/2009) and of the current literature. 
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Tabelle 2. Chromosomal mapping of Mentype® Pentaplex ESS 
Locus Chromosomal mapping   
Amelogenin X Xp22.1-22.3   
Amelogenin Y Yp11.2   
D1S1656 1q42   
D2S441 2p14   
D10S1248 10q26.3   
D12S391 12p13.2   
D22S1045 22q12.3   
 
 
Content 

Mentype ® Pentaplex ESS PCR Amplification Kit (100 Reactions) 
Nuclease-free water 3.0 mL 
Reaction mix A 500 μL 
Primer mix 250 μL 
DNA polymerase 40 μL 
Control DNA XY13 (2 ng/μL) 10 μL 
DNA size standard 550 (ROX) 50 μL 
Allelic ladder  10 μL 
 
 
Ordering information  
Mentype® Pentaplex ESS 25 reactions Cat. No. 41-06210-0025 
Mentype® Pentaplex ESS 100 reactions Cat. No. 41-06210-0100 
Mentype® Pentaplex ESS 400 reactions Cat. No. 41-06210-0400 

 
 
Storage 

Store all components at –20°C and avoid repeated thawing and freezing. Primer mix 
and allelic ladder must be stored protected from light. The DNA samples and post-PCR 
reagents (allelic ladder and DNA size standard) should be stored separately from the 
PCR reagents. The expiry date is indicated on the kit cover.  
 
 
Quality assurance 

All kit components undergo an intensive quality assurance process at Biotype 
Diagnostic GmbH. The quality of the test kits is permanently monitored in order to 
ensure unrestricted usability. Please contact us if you have any questions regarding 
quality assurance. 
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Additionally required reagents 

Additional reagents are needed in order to use the Biotype® PCR Amplification Kit: 
Reagent Supplier Order number 
Hi-Di™ Formamide, 25 mL Applied Biosystems 4311320 
Matrix Standards DS-30 
for ABI PRISM® 310 Genetic Analyzer Applied Biosystems 401546 and 402996 (NED) 

Matrix Standards DS-30 
for ABI PRISM® multi-capillary instruments Applied Biosystems 4345827 

 
 
Trademarks and patents 

Mentype® is a registered trademark of Biotype Diagnostic GmbH. 
ABI PRISM®, GeneScan®, Genotyper®, GeneMapper™ and Applied Biosystems are 
registered trademarks of Applied Biosystems Inc. or its subsidiaries in the U.S. and 
certain other countries. 
6-FAM, HEX, NED, ROX, POP-4 and Hi-Di are trademarks of Applied Biosystems Inc. 
GeneAmp® is a registered trademark of Roche Molecular Systems. 
The PCR is covered by patents. Patentees are Hoffmann-La Roche Inc. and 
F. Hoffmann-La Roche (Roche). 
GenBank® is a trademark of National Institute of Health. 
 
NOTICE TO PURCHASER: LIMITED LICENSE 
 
This product is sold under licensing arrangements between Licensee and Life Technologies Corporation. The 
purchase price of this product includes limited, nontransferable rights under certain U.S. and foreign patent(s) 
owned by Life Technologies Corporation to use only this amount of the product to practice the claims in said 
patents solely for activities of the purchaser in the field of human or animal identification. No other rights are 
conveyed. Further information on purchasing licenses under the above patents may be obtained by contacting 
the Licensing Department, Life Technologies Corporation, 5791 Van Allen Way, Carlsbad, California 92008. 
Email: outlicensing@lifetech.com. 
 
Warnings and safety instructions 

The PCR Amplification Kit contains the following potentially hazardous chemicals: 
Kit Component Chemical Hazards 
Primer mix, reaction mix 
and allelic ladder 

Sodium azide NaN3 toxic if swallowed, develops toxic gases 
when it gets in contact with acids  

Observe the Material Safety Data Sheets (MSDS) for all Biotype® products, which are 
available on request. Please contact the respective manufacturers for copies of the 
MSDS for any additionally needed reagents. 
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1. PCR amplification 

1.1 Master mix preparation 

The table below shows the volumes of all PCR reagents per 25 μL reaction volume, 
including a sample volume of 1.0 μL (template DNA). The number of reactions to be 
set up shall be determined taking into account positive and negative control reactions. 
Add one or two reactions to this number to compensate the pipetting error. 
 
Component Volume 
Nuklease-free water 16.1 μL 
Reaction mix A* 5.0 μL 
Primer mix 2.5 μL 
Multi Taq2 DNA Polymerase (hot start, 2.5 U/μL) 0.4 μL 
Volume of master mix 24.0 μL 

* contains Mg2+, dNTPs, BSA 
 
All components should be mixed (vortex) and centrifuged for about 10 s before 
preparing the master mix. The DNA volume applied to the assay depends on its 
concentration. A volume of up to 5 μL may be necessary for DNA trace templates. DNA 
volumes of more than 5 μL are not recommended, because potential PCR inhibitors 
may interfere with the process. Fill up the final reaction volume to 25 μL with 
nuclease-free water. 
 
Generally, DNA templates shall be stored in nuclease-free water or in diluted TE buffer 
(10 mM Tris HCl, pH 8.0 and 1 mM EDTA), e.g. 0.1x TE buffer. 
 
The primer mixes are adjusted for balanced peak heights at 30 PCR cycles and 
0.2 ng Control DNA XY13 in a reaction volume of 25 μL. If more DNA template is 
introduced, higher peaks can be expected for small PCR fragments and relatively low 
peaks for large fragments. Reduce the amount of DNA template to correct this 
imbalance. 
 
 
Positive control 

For the positive amplification control, dilute the Control DNA XY13 to 0.2 ng in the 
appropriate volume. Instead of the template DNA pipette the diluted Control DNA into a 
reaction tube containing the PCR master mix. 
 
Negative control 
For the negative amplification control, pipette nuclease-free water instead of template 
DNA into a reaction tube containing the PCR master mix. 
 
Template DNA 

Sometimes, the measured value of the DNA concentration varies depending on the 
quantification method used, so that it may be necessary to adjust the optimal DNA 
amount. 

Protocols for PCR amplification, electrophoresis, and analysis 
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1.2 PCR amplification parameter 

Perform a “hot start” PCR in order to activate the Multi Taq2 DNA Polymerase and to 
prevent the formation of non-specific amplification products. 
 
The number of cycles depends on the amount of DNA. 30 cycles are recommended for 
all samples. For critical stains (< 100 pg DNA), it is recommended to increase the 
number of PCR cycles from 30 to 32. 
 
Standard Method  
Recommended for all DNA samples  
Temperature Time 
94°C 4 min (hot start for activation of the Multi Taq2 DNA Polymerase) 
94°C 30 s 
60°C 120 s 
72°C 75 s 

30 cycles 

68°C 60 min  
10°C ∞ hold 

 
 
Optional 

Recommended for stains with small amounts of DNA 
Temperature Time 
94°C 4 min (hot start for activation of the Multi Taq2 DNA Polymerase) 
94°C 30 s 
60°C 120 s 
72°C 75 s 

32 cycles 

68°C 60 min  
10°C ∞ hold 
 
 
Too small amounts of DNA may result in allelic dropouts and imbalances of the peaks. 
Furthermore, unspecific amplification products could appear. With increasing numbers 
of cycles, there is the risk of cross contamination caused by minimal amounts of 
impurities. 
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2. Electrophoresis using the ABI PRISM® 310 Genetic Analyzer 

For general instructions on instrument setup, matrix generation and application of the 
GeneScan® or GeneMapper™ ID software, refer to the ABI PRISM ® 310 Genetic 
Analyzer User’s Manual. Electrophoresis using the GeneScan® software is described 
below.  
 
The virtual filter set D shall be used for combined application of the four fluorescent 
labels 6-FAM, HEX, NED, and ROX (also called DS-30). Generally, Filter Sets A and F 
are suitable, too. 
 
Material  
Capillary 47 cm / 50 μm (green) 
Polymer POP-4 for 310 Genetic Analyzer  
Buffer 10x Genetic Analyzer Buffer with EDTA 
 
 

2.1 Matrix generation 
Prior to conducting DNA fragment size analysis with the filter set D, a matrix with the 
four fluorescent labels 6-FAM, HEX, NED, and ROX must be generated. The suitable 
matrix standard DS-30 is available from Applied Biosystems. 
 
Colour Matrix standard Order number 
Blue (B) 6-FAM Applied Biosystems, 401546 
Green (G) HEX Applied Biosystems, 401546 
Yellow (Y) NED Applied Biosystems, 402996 
Red (R) ROX Applied Biosystems, 401546 
 
Four electrophoresis runs shall be conducted, one for each fluorescent label, 6-FAM, 
HEX, NED, and ROX, under the same conditions as for the samples and allelic ladders 
of the Biotype® test kit to generate suitable matrix files. 
 
Matrix sample Component Volume 

Hi-Di™ Formamide 12.0 μL 
Matrix sample 1 

Matrix standard 6-FAM 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 2 Matrix standard HEX 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 3 

Matrix standard NED 1.0 μL 
   

Hi-Di™ Formamide 12.0 μL 
Matrix sample 4 

Matrix standard ROX 1.0 μL 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
- For analysis: load the samples on the tray 
 
- Create a Sample Sheet and enter sample designation 
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Injection list for matrix generation 
Parameter Set up 
Module File GS STR POP-4 (1 mL) D 
Matrix File NONE 
Size Standard* NONE 
Injection [s] 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min] 24 

* prepare matrix standards always without DNA Size Standard (ROX)  
 
 
Analysis of the matrix samples 

- Run the GeneScan® software 
- File → New → Project (open folder of current run) → Add Sample Files 
- Select a matrix sample in the Sample File column  
- Sample → Raw Data 
- Check the matrix samples regarding a flat baseline. As shown in the figure below, 

there should be at least five peaks with peak heights about 1000-4000 (Y-axis) for 
each matrix sample (optimal range: 2000-4000) 

 

 
Fig. 1 Electropherogram with raw data of the matrix standard 6-FAM 
 
- Select analysis range with flat baseline and re-inject the matrix sample if necessary 
- Note down start and end value (data points) of the analysis range, e.g.  
   start value 3400, end value 6400 
- Calculate the difference, e.g. 6400-3400 = 3000 data points 
 

 ▼ 3400 Data Points (X) 
 

 6400▼ 
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Generation of a new matrix 

- File → New → Matrix 

 
Fig. 2 Matrix sample selection 

 
- Import matrix samples for all dyes (B, G, Y, R) 
- Enter a Start At value, e.g. 3400 
- Enter the calculated difference under Points, e.g. 3000 
- Click on OK to calculate the new matrix 
 

 
Fig. 3 New matrix DS-30  
 
- Save the matrix in the matrix folder: File → Save as, e.g. Matrix DS-30 
 
 
Matrix check 

Check the new matrix with current samples. 
- File → New → Project (open folder of the respective run) → Add Sample Files 
- Select sample(s) in the Sample File column  
- Sample → Install New Matrix (open matrix folder and select new matrix) 
- Re-analyse your samples 
 
There should be no pull-up peaks between the dye panels (B, G, Y, R) with the new 
matrix. 
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2.2 Sample preparation 
Component Volume 
Hi-Di™ Formamide 12.0 μL 
DNA Size Standard 550 (ROX) 0.5 μL 
prepare 12 μL of the mix (formamide + DNA size standard) for all samples  
add 1 μL PCR product (diluted if necessary) or allelic ladder  
- Denaturation for 3 min at 95°C  
- Cool down to 4°C  
- For analysis: load the samples on the tray  
 
 
Signal intensities 

Options to increase the signal intensity: 
- Reduce the volume of the DNA Size Standard 550 (ROX) to peak heights of  

about 500 relative fluorescent units (RFU)  
- Purify the PCR products before starting the analysis  
 
 

2.3 Setting up the GeneScan® software 

- Create a Sample Sheet and enter sample designation 
 
Injection list 
Parameter Set up 
Module File GS STR POP-4 (1 mL) D 
Matrix File e.g. Matrix DS-30 
Size Standard e.g. SST-ROX_50-240bp 
Injection [s]* 5 
Injection [kV] 15.0 
Run [kV] 15.0 
Run [°C] 60 
Run Time [min]** 20 

* Deviating from standard settings, the injection time may range between 1 and 10 s depending on the type of 
sample. If samples with very high signal intensities are recorded, a shorter injection time may be selected. For 
samples with low DNA content an injection time up to 10 s may be necessary.  

 
** Depending on the analysis conditions the run time for Mentype® Pentaplex ESS was modified in order to 
analyse fragments with lengths of up to 240 bp. 
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2.4 Analysis parameter 

The recommended analysis parameters are: 
 
Analysis Range Start: 2000 

Stop: 10000 
Data Processing Baseline: Checked 

Multicomponent: Checked 
Smooth Options: Light 

Peak Detection Peak Amplitude Thresholds 
B:*    Y:* 
G:*    R:* 
Min. Peak Half Width: 2 pts 
Polynorminal Degree: 3 
Peak Window Size: 11 pts** 

Size Call Range Min: 50 
Max: 550 

Size Calling Method Local Southern Method 
Split Peak Correction None 

 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be detected by 
the GeneScan® or GeneMapper™ ID software. Thresholds are usually 50-200 RFU and should be determined 
individually by the laboratory. Recommendation: The minimal peak height should be three times as high as the 
background noise of the baseline. 

 
** Point alleles (i.e. alleles with at least 1 bp difference to the next integer allele) may occasionally not be 
distinguished. For improved peak detection, minimise the Peak Window Size further. 
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3. Electrophoresis using the ABI PRISM® 3130/3130xl Genetic Analyzer 

For detailed instructions on instrument setup, spectral calibration, or application of the 
ABI PRISM® Data Collection software version 3.0 and the GeneMapper™ ID software, 
refer to the ABI PRISM ® 3130/3130xl Genetic Analyzers Getting Started Guide.  
 
The system with 4 capillaries is named ABI 3130 (former ABI 3100-Avant), and the 
system with 16 capillaries is named ABI 3130xl (former ABI 3100).  
 
The virtual filter set D shall be used for combined application of the four fluorescent 
labels 6-FAM, HEX, NED, and ROX (also called DS-30). 
 
Material  
Capillary 36 cm Capillary Array for 3130/3130xl 
Polymer POP-4 Polymer for 3130 
Buffer 10x Genetic Analyzer Buffer with EDTA 
 
 

3.1 Spectral calibration / matrix generation 

Prior to conducting DNA fragment size analysis, it is necessary to perform a spectral 
calibration with the four fluorescent labels 6-FAM, HEX, NED, and ROX for each 
analyzer. The calibration procedure creates a matrix which is used to correct the 
overlapping of fluorescence emission spectra of the dyes.  
 
Spectral calibration comprises the following steps: 
- Preparation the spectral calibration standards 
- Loading the standards to the 96-well reaction plate (one sample per capillary) 
- Creating the instrument protocol for spectral calibration (Protocol Manager) 
- Defining the plate composition in the plate editor (Plate Manager) 
- Performing a spectral calibration run and checking the matrix 
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Setting up the spectral calibration standards 

Example for 4 capillaries/ABI 3130 
Component Volume 
Hi-Di™ Formamide 47.5 μL 
Matrix standard DS-30 2.5 μL 
- Load 12 μL of the mix to a 96-well reaction plate, e.g. position A1-D1 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
 
 
Example for 16 capillaries/ABI 3130xl 
Component Volume 
Hi-Di™ Formamide 190.0 μL 
Matrix standard DS-30 10.0 μL 
- Load 12 μL of the mix to a 96-well reaction plate, e.g. position A1-H1 and A2-H2 
- Denaturation for 3 min at 95°C 
- Cool down to 4°C 
 
 
Performing a spectral calibration run 

- Place the 96-well plate on the autosampler tray 
- In the Protocol Manager of the Data Collection software click New the window 

Instrument Protocol to open the Protocol Editor dialog box 
 
 
Instrument Protocol for spectral calibration 
Protocol Editor Set up 
Name User (e.g. Spectral36_POP4_DS30) 
Type SPECTRAL 
Dye Set D 
Polymer* User (e.g. POP4) 
Array Length* User (e.g. 36cm) 
Chemistry Matrix Standard 
Run Module* Default (e.g. Spect36_POP4_1) 

* Depends on the type of polymer and length of capillary used 
 
- Select OK to complete the Protocol Editor dialog box 
- In the Plate Manager of the Data Collection software click New to open the New 

Plate Dialog box 
 
Plate Editor for spectral calibration (I) 
New Plate Dialog Set up 
Name e.g. Spectral_DS-30_date 
Application Spectral Calibration 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- Click on OK. A new table in the Plate Editor opens automatically 
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Plate Editor for spectral calibration (II) 
Parameter Set up 
Sample Name Type name for the matrix samples 
Priority  e.g. 100  
Instrument Protocol 1 Spectral36_POP4_DS30 (setting described before) 
 
- Click into the column header to select the entire column, select Edit → Fill Down to 

apply the information to all selected samples, and click on OK 
- In the Run Scheduler click on Find All, select Link to link the reaction plate on the 

autosampler up with the newly created plate record (position A or B) and start the run 
 

 
Fig. 4 Electropherogram with raw data of the matrix standard DS-30 on an ABI 3130 

 
 
Matrix check 

- The quality value (Q value) of each capillary must be greater than 0.95 and the  
   condition number range (C value) must be between 1 and 20. 
- Check the matrix samples for a flat baseline. As shown in the figure above, there 

should be four peaks with peak heights of about 1000-5000 (Y-axis) in each matrix 
sample (optimal range: 2000-4000) 

- Check the new matrix with your current samples. There should be no pull-up peaks 
between the dye panels (B, G, Y, R) with the new matrix 

- If calibration was not successful, use the optimised values and repeat the calibration 
run 

- If all capillaries have passed the test, the last calibration file for the Dye Set D is 
activated automatically in the Spectral Viewer. Rename the calibration file (e.g. 
DS-30_Date of calibration) using the respective button 

        R, Y,   G,     B 
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3.2 Sample preparation 
Component Volume 
Hi-Di™ Formamide 12.0 μL 
DNA Size Standard 550 (ROX)   0.5 μL 
prepare 12 μL of the mix (formamide + DNA size standard) for all samples 
add 1 μL PCR product (diluted if necessary) or Allelic Ladder 
- Denaturation for 3 min at 95°C  
- Cool down to 4°C  
- For analysis: load the samples on the tray  
 
Since injections take place simultaneously on all capillaries, 4 or 16 samples must be 
pipetted on the plate of multi-capillary analysers. If fewer samples are analysed, the 
empty positions must be filled with 12 μL Hi-Di™ Formamide. 
 
To ensure a reliable allelic assignment on multi-capillary analysers, several ladders 
should be run. 
 
Room temperature may influence the performance of PCR products on multi-capillary 
instruments, so that shoulder peaks or split peaks occur especially at low 
temperatures. Pay attention to keeping ambient conditions as recommended by the 
instrument manufacturer. 
 
 
Signal intensities 

Options to increase the signal intensity: 
- Reduce the volume of the DNA Size Standard 550 (ROX) to peak heights of about 

500 relative fluorescent units (RFU)  
- Purify the PCR products before starting the analysis 
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3.3 Setting up the GeneMapper™ ID software 

Edit the Run Module as follows for the first run: 
- In the Module Manager of the Data Collection software click on New to open the 

Run Module Editor dialog box 
 
Run Module 3kV_10s_260bp 
Parameter Set up 
Oven Temperature [°C] Default 
Poly Fill Volume Default 
Current Stability [μA] Default 
PreRun Voltage [kV] Default 
PreRun Time [s] Default 
Injection Voltage [kV] 3.0 
Injection Time [s]* 10 
Voltage Number of Steps Default 
Voltage Step Interval Default 
Data Delay Time [s] Default 
Run Voltage [kV] Default 
Run Time [s]** 900 

* Deviating from the standard settings, the injection time may range between 1 and 20 s depending on the type 
of sample. If samples with very high signal intensities are recorded, a shorter injection time may be selected. 
For samples with low DNA content an injection time of up to 20 s may be necessary.  
 
** Depending on the analysis conditions the run time for Mentype® Pentaplex ESS was modified in order to be 
able to analyse fragments with lengths of up to 240 bp. 

 

- Click on Save As, enter the name of the new module (e.g. 3kV_10s_260bp) and confirm 
with OK 

- Click on Close to exit the Run Module Editor 
 
 
Starting the run 

- Place the prepared 96-well plate on the autosampler tray 
- In the Protocol Manager of the Data Collection software, click on New in the 

Instrument Protocol window to open the Protocol Editor dialog box 
 
 
Instrument Protocol 
Protocol Editor Set up 
Name e.g. Run36_POP4_DS-30_15min 
Type REGULAR 
Run Module* 3kV_10s_260bp 
Dye Set D 

* parameter see above 
 
- Click on OK to exit the Protocol Editor 
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Prior to each run, it is necessary to create a plate definition as follows: 
- In the Plate Manager of the Data Collection software click on New to open the New 

Plate Dialog box 
 
GeneMapper™ Plate Editor (I) 
New Plate Dialog Set up 
Name e.g. Plate_DS-30_Date 
Application select GeneMapper Application 
Plate Type 96-Well 
Owner Name / Operator Name … 
 
- Click OK. A new table in the Plate Editor opens automatically 
 
GeneMapper™ Plate Editor (II) 
Column  Set up 
Sample Name Type name for the samples 
Priority  e.g. 100 (Default) 
Sample Type Sample or Allelic Ladder 
Size Standard e.g. SST-ROX_50-240bp 
Panel e.g. Biotype_Panels_ v3a (choose test kit) 
Analysis Method e.g. Analysis_HID_3130 
Snp Set - 
User-defined 1-3 - 
Results Group 1 (select results group) 
Instrument Protocol 1 Run36_POP4_DS-30 (setting described earlier) 
 
- Click into the column header to select the entire column, select Edit → Fill Down to 

apply the information to all selected samples and click on OK 
- In the Run Scheduler, click on Find All, select Link to link the reaction plate on the 

autosampler up with the newly created plate record (position A or B) and start the run  
- During the run, view Error Status in the Event Log or examine the quality of the raw 

data for each capillary in the Capillaries Viewer or the Cap/Array Viewer 
- View data as overview in Run History or Cap/Array Viewer of the Data Collection 

software. Run data are saved in the Run Folder of the previously chosen Result 
Group 
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3.4 Analysis parameter / analysis method 

The recommended settings in the worksheet Peak Detector are: 
 
Peak Detection Algorithm Advanced 
Ranges Analysis: Partial Range 

Start Pt: 2000; Stop Pt: 10000 
Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  
Baseline Window: 51 pts 

Size Calling Method Local Southern Method 
Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 
G:*    R:* 
Min. Peak Half Width: 2 pts 
Polynominal Degree: 3 
Peak Window Size: 11 pts** 
Slope Thresholds: 0.0 

 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be detected by 
the GeneMapper™ ID software. The thresholds are usually 50-200 RFU and should be determined individually 
by the laboratory. Recommendation: The minimal peak height should be three times as high as the background 
noise of the baseline. 
 
** Point alleles (i.e. alleles with at least 1 bp difference to the next integer allele) may occasionally not be 
distinguished. For improved peak detection, minimise the Peak Window Size further. 
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4. Analysis 

For general instructions on automatic sample analysing, refer to the GeneScan® or 
GeneMapper™ ID Software User’s Manual.   
 
Finding the exact lengths of the amplified products depends on the device type, the 
conditions of electrophoresis, as well as the DNA size standard used. Due to the 
complexity of some loci, determining the size should be based on evenly distributed 
references. The DNA Size Standard 550 (ROX) shall thus be used with the following 
lengths of fragments: 50, 60, 70, 80, 90, 100, 120, 140, 160, 180, 190, 200, 220, 
240, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 500, 525, and 550 
bp.  
 

 
Fig. 5 Electropherogram of the DNA Size Standard 550 (ROX), fragments with lengths in bp 

 
 
Note: The basic template files for the DNA Size Standard 550 (ROX) has to be adjusted 
to 240 bp within the GeneMapper™ ID software. The new template could be saved as 
e.g. SST-ROX_50-240bp and used for further analyses.  
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4.1 Biotype® template files 

Allele allocation should be carried out with a suitable analysis software, e.g. 
GeneMapper™ ID or Genotyper® software in combination with the Mentype®  
Pentaplex ESS template file from Biotype. Template files are available from our 
homepage or as CD-ROM on request.  
 
Recommended Biotype® templates for GeneMapper™ ID/ID-X software are: 
Panels Biotype_Panels_v3a/v3X (choose kit) or higher versions 
BinSets Biotype_Bins_v3a/v3X or higher versions 
Size Standard SST-ROX_50-500bp (adjust to 240bp adjustment 

described earlier) 
 

Analysis_HID_310  
Analysis_HID_3130  
Analysis_HID_310_50rfu  

Analysis Method 

Analysis_HID_3130_50rfu  
Plot Settings Plots_4dyes  
Table Settings Table for 2 Alleles   
 Table for 10 Alleles  
 
Panels and BinSets always have to be used whereas the other template files are 
optional.  
 

Additional Biotype® templates for GeneMapper™ ID-X Software: 
Stutter* Biotype_Stutter_v3X or higher version 

* When loading the above mentioned panels, the stutter settings will not be accepted. Thus, the stutter data has 
to be imported separately.  
 

Recommended Biotype® template files for Genotyper® software are: 
Pentaplex_ESS_v1 or higher versions  
 

General procedure for the analysis 
1. Check the DNA size standard 
2. Check the allelic ladder 
3. Check the positive control 
4. Check the negative control 
5. Analyse and interpret the sample data 
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4.2 Controls 

The Control DNA XY13 of the test kit and other commercially available DNA from 
standard cell lines represent the following alleles: 
 
Table 3. Allele assignment of Mentype® Pentaplex ESS 

Locus Control 
DNA XY13 

ATCC 
K-562 

CCR 
9947A 

CCR 
9948 

CCR 
3657 

Amelogenin X / Y X / X X / X X / Y X / Y 
D1S1656 16 / 17.3 15 / 16 18.3 / 18.3 14 / 17 13 / 18.3 
D2S441 10 / 11 10 / 14 10 / 14 11 / 12 14 / 14 
D10S1248 14 / 15 12 / 12 13 / 15 12 / 15 14 / 16 
D12S391 16 / 18 23 / 23 18 / 20 18 / 24 18 / 19 
D22S1045 17 / 18 16 / 16 11 / 14 16 / 18 11 / 17 
 
For further confirmation, the table above displays the alleles of the reference DNA      
purchased from ATCC (http://atcc.org/Produtcs/PurifiedDNA.cfm#celllines) as well as 
three reference DNA purchased from Coriell Cell Repositories (CCR; 
http://locus.umdnj.edu/nigms/) that is up to standard of Szibor et al. (2003). 
 
 

4.3 Lengths of fragments and alleles 

Table 4 to Table 6 show the fragment lengths of individual alleles that refer to the 
DNA Size Standard 550 (ROX). All analyses have been performed on an 
ABI PRISM® 310/3130 Genetic Analyzer with POP-4 polymer. Different analysis 
instruments, DNA size standards or polymers may result in different fragment lengths.  
In addition, a visual alignment with the allelic ladder is recommended. 
 
 
Scaling 

Horizontal: 75-245 bp 
Vertical:  Depending on signal intensity
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Figure 6 
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 Figure 7 
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Table 4. Fragment lengths of the allelic ladder Mentype® Pentaplex ESS analysed  
on an ABI PRISM® 310/3130 Genetic Analyzer (blue panel) 

Allele/Marker Size [bp]* Allele/Marker Size [bp]* Further Alleles** Allele/Marker Size [bp]* Further Alleles** 

Amelogenin 6-FAM D22S1045 6-FAM  D12S391 6-FAM  

X 88 10 122 7, 8, 9 15 179 14 

Y 91 11 125  16 183  

  12 128  17 187 17.3 

  13 131  18 191 18.3 

  14 134  19 195 19.1, 19.3 

  15 137  20 199 20.3 

  16 140  21 203  

  17 143  22 207  

  18 146  23 211  

  19 149 20 24 215  

     25 219  

     26 223 27 

Table 5. Fragment lengths of the allelic ladder Mentype® Pentaplex ESS analysed  
on an ABI PRISM® 310/3130 Genetic Analyzer (green panel) 
 
Allele/Marker Size [bp]* Further Alleles** Allele/Marker Size [bp]* Further Alleles** 

D10S1248 HEX  D1S1656 HEX  

10 91 8, 9 10 153 9 

11 95  11 157  

12 99  12 161  

13 103  13 165  

14 107  14 169 14.3 

15 111  15 173 15.3 

16 115  16 177 16.3 

17 119  17 181 17.1 

18 123  17.3 184  

19 127  18.3 188 18 

   19.3 192 19, 20.3 
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Table 6. Fragment lengths of the allelic ladder Mentype® Pentaplex ESS analysed  
on an ABI PRISM® 310/3130 Genetic Analyzer (yellow panel) 

 
Allele/Marker Size [bp]* Further Alleles** 

D2S441 NED  

 8 82 9 

10 90  

11 94  

11.3 97  

12 98 12.3 

13 102 13.1 

14 106  

15 110  

16 114 17 

   

* rounded to integer 

** The “off-ladder” alleles of Biotype’s DNA pool are allocated with the actual Biotype® template files for GeneMapper™ ID 
or Genotyper® software. For further alleles see amongst others http://www.cstl.nist.gov/biotech/strbase/str_fact.htm  
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5. Interpretation of results 

As mentioned above, post PCR analysis and automatic allele assignment with 
suitable analysis software ensure a precise and reliable discrimination of alleles. 
 
Pull-up peaks 

Pull-up peaks may occur if peak heights are outside the linear detection range 
(>3000 RFU), or if an incorrect matrix was applied. They appear at positions of 
specific peaks in other colour channels, typically with lower signal intensities. 
Peak heights should not exceed 3000 RFU in order to prevent pull-up peaks.  
 
Stutter peaks 

The occurrence of stutter peaks depends on the sequence of the repeat structure 
and the number of alleles. n-4 peaks are caused by a loss of a repeat unit during 
amplification of tetranucleotide STR motives, caused by slippage effects of the 
Taq DNA Polymerase, whereas n-3 peaks appear particularly during amplification 
of the trinucleotide STR motif D22S1045. Those peaks should be interpreted in 
accordance with the template files of the Genotyper® and GeneMapper™ ID 
software. 
 
Template-independent addition of nucleotides 

Because of its terminal transferase activity, the Taq DNA Polymerase tends to add 
an adenosine radical at the 3’-end of the amplified DNA fragments. The artefact 
peak is one base shorter than expected (-1 peaks). All Biotype® primers are 
designed to minimise these artefacts. Artefact formation is further reduced by the 
final extension step of the PCR protocol at 68°C for 60 minutes. Peak height of 
the artefact correlates with the amount of DNA. Laboratories should define their 
own limits for analysis of the peaks. 
 
Artefacts  

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur. If shoulder or 
split peaks appear, we recommend injecting the sample again. 
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Notes 
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